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Quick Start Guide 

 
 
Introduction 
 
Cognero is a full-featured, online assessment system that allows you to manage your content, 
create and assign tests, deliver tests through a secure online test center, and have complete 
reporting and data dissemination at your fingertips. Cognero combines the functionality you'd 
expect from a desktop test generator with the convenience of the Web. Every tool you need to 
create professional paper and online tests is available without the need for a desktop 
application. Just launch your browser and get started! 
 
With Cognero you can... 
 

• Create paper and online tests using nothing but a web-browser. 
• Drag and drop questions to create tests. 
• Create and edit your own questions, as well as edit publisher-created question sets. 
• Administer secure online tests. 
• Track student progress through comprehensive reporting. 
• Send tests and student results to learning management systems. 

 
 
Key features of Cognero include: 
 

• Support for many question types including true/false, multiple choice, matching, 
numeric response, completion, essay, and Likert scale 

• Rich word processing features including support for equations, images, and tables 
• Algorithm engine to create dynamic questions 
• Support for a wide variety of question meta-data including local, state, and national 

standards 
• Support for many standard import and export methods including IMS QTI and XML 

 
 
System Requirements 
 

• an internet connection 
• a Web browser 

o Firefox 3.x and higher (recommended for Windows) 
o Safari 3.1 and higher (recommended for Macintosh) 
o Internet Explorer 7.x and higher 

• Java runtime environment (free download from http://www.java.com)  
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Cognero Components 
 
Instructors using Cognero have access to three distinct components in order to complete their 
assessment tasks. These components are: 
 

• Test Generator: This component enables you to create and edit question sets and 
tests. 

• Classes and Assignments: This component enables you to create and edit class rosters 
and to assign online tests to your classes. 

• Reporting: This component enables you to view and print detailed class and individual 
reports on your students’ results. 

 
To move between the components of Cognero, simply choose the component with which you 
want to work from the Section drop-down menu. 
 

 
Figure 1: Section menu
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Register and Log In 
 
You can begin using Cognero immediately, with no software installation required.  
 

 
Figure 2: Cognero log-in window 
 
 
To begin using Cognero: 
 

1. Launch your web browser. 
2. Navigate to http://www.cognero.com and click Instructor Log In.  
3. If you have already registered, enter your email address and password and click the OK 

button. 
4. If you don’t have a Cognero account, click the Register button and provide the 

requested information. A Cognero authorization code is required for registration. If you 
don’t have an authorization code, please contact your textbook publisher. 
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The Cognero Test Generator Window 
 

 
Figure 3: Test generator window 
 
The Cognero Test Generator window is organized into three parts: 
 

• Question Sets Pane: The question sets pane displays your question sets in a folder 
structure. Question sets may be provided by your textbook publisher, and you can also 
create your own question sets. Publisher-created questions sets are typically organized 
by textbook chapters or units. 

• Tests Pane: The tests pane displays your tests in a folder structure. Prepared tests may 
be provided by your textbook publisher, and you can also create your own tests. 

• Editor Pane: Drag a question set or test to the editor pane to make changes to it. You 
can edit existing questions, add or delete questions, change formatting, and print from 
the editor pane. 

 
At the heart of Cognero’s design is a drag-and-drop simplicity that allows content movement 
from any pane to any other pane. Drag a question set from the question sets pane to the editor 
pane to open it for editing. Drag a question from the editor pane to the tests pane to add it to 
a test. With Cognero’s intuitive features, you’ll be an expert in no time! 
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Working with Question Sets and Test 
 
Your Cognero content is stored in question sets and tests. Question sets and tests are similarly 
organized and may be edited interchangeably. Typically, new content is created as question 
sets, which are often organized by textbook chapter or topic area. Instructors then may use 
these question to create a test. There is no limit to the number of questions that may be 
stored in a question set or used in a test. 
 
To open an existing question set or test: 
 

1. Expand folders in the question sets or tests pane as necessary until you can see the 
question set or test you want to open. 

2. Drag the question set from the question sets or tests pane into the editor pane. 
 
 
To create a new question set: 
 

1. Select the folder in the question sets pane in which you would like your new question 
set to be created. 

2. Click the Create a new question set link in the editor pane. 
 

 
Figure 4: New  question set link 

 
3. Enter a question set title and, optionally, a subtitle. 
4. Select one or more languages for your question set. 
5. Click the OK button. Your empty question set is displayed in the editor pane. 
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To create a new test: 
 

1. If necessary, close the currently open test or question set. 
2. Click the Create a new test link in the editor pane. 

 

 
Figure 5: New test link 

 
3. Enter a test title. 
4. Select a location for the test. You can choose an existing folder or create a new one. 
5. Choose a build option and click the Next button. 

• If you want Cognero to randomly choose questions from selected question 
sets/tests, choose the Quickly build the test with questions option. 

• If you want to select specific questions for your test or create questions from 
scratch, choose the Create an empty test option and click the Finish button. Skip 
ahead to the next topic in this guide. 

6. Click the check boxes next to the question sets/tests from which you would like 
questions to be selected, and then click the Next button. 

7. Click the check boxes to select the language versions you want available for your test. 
Note: If your content is not already created in foreign languages, you will be 
responsible for translating. 

8. Select how many questions of each type to include on the test and click Next. 
• You can individually enter the number of each type of question, or… 
• You can enter a number in the Automatically select field and click the Select 

button to randomly select a distribution of question types. 
9. Review the information on the summary screen. Click the Finish button to build your 

test and open it in the editor pane, or click the Back button to change your selections. 
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To create a new question in a question set or test:  
 

1. Open a test or question set by dragging it to the editor pane. 
2. Click the  (new question) button or choose New Question from the Question menu. 
3. Specify the type of question you would like to create. Cognero offers a variety of 

question types to enable you to create a test to your exact specifications. 
 
Cognero Question Types 
• True/False: Question with an answer of either true or false 
• Modified True/False: Question with an answer of either true or false. If the 

answer is false, students must also provide a word or phrase to make the statement 
true. 

• Yes/No: Question with an answer of either yes or no 
• Multiple Choice: Students choose one correct answer from the choices provided 
• Multiple Response: Students choose one or more correct answers from the choices 

provided 
• Numeric Response: Question with a numeric answer. 
• Completion: Question with a one-word or short phrase answer 
• Matching: Students match questions to appropriate answer choices 
• Objective Short Answer: Question with text answer that can be automatically 

graded 
• Subjective Short Answer: Question with text answer that cannot be automatically 

graded 
• Multi-Mode: Question that can toggle between multiple choice and objective short 

answer. Toggling questions enables instructors to quickly and easily change the 
difficulty level of a test 

• Ordering: Students must put answer choices in the correct series 
• Opinion Scale/Likert: Students rate their agreement with a statement 
• Essay: Question with answer in paragraph form 
• Custom: Question with customized instructions. You can create as many custom 

question types as you need. 
• RIA: Rich internet application questions are developed by publishers for use with 

online tests. 
 

4. Enter the question content, answer, and question information. 
5. Click the OK button to record your question or click the Create Another button to 

create another question of the same type. 
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Editing, Deleting, and Duplicating Questions 
 
When working with a question set or test, you may wish to edit or delete an existing question. 
You may also want to make a copy of a question to use as the basis for a similar question. 
These tasks can all be accomplished in the editor pane. 
 
To edit an existing question: 
 

1. Open a test or question set by dragging it to the editor pane. 
2. Use your mouse to point to the question you wish to edit. 
3. Click the pencil icon to the left of the question and choose the Edit option. 

 

 
Figure 6: Edit a question 

 
4. Edit the question, answer, and question information as desired. When you are finished, 

click the OK button. 
 
 

To delete an existing question: 
 

1. Open a test or question set by dragging it to the editor pane. 
2. Use your mouse to point to the question you wish to delete. 
3. Click the pencil icon to the left of the question and choose the Delete option. 
4. Click the Yes button to confirm the deletion. 

 
 
To duplicate an existing question: 
 

1. Open a test or question set by dragging it to the editor pane. 
2. Use your mouse to point to the question you wish to duplicate. 
3. Click the pencil icon to the left of the question and choose the Duplicate option. 
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Prefaces 
 
When creating questions, you may wish to link multiple questions to a single table, chart, 
picture, or passage instead of repeating the information for each question. This shared item is 
known as a preface. All questions attached to a preface will stay together as a group in a 
question set or test. In the example below questions 3, 4, and 5 are all attached to a preface. 
 

 
Figure 7: Three questions attached to a preface 
 
 
To create a new preface: 
 

1. Open a test or question set by dragging it to the editor pane. 
2. Choose Prefaces from the Test menu. 
3. Click the New button to create a new preface. 
4. Enter a name for your preface. 
5. Enter the content of the preface and click the OK button. 
6. When you are finished creating prefaces, click the Done button. 

 
To attach a preface to a question: 
 

1. Edit the question to which you want to attach a preface. 
2. Click the Info tab. 
3. Choose a preface from the Preface drop-down list. You can also click the Preface 

button to create a new preface. 
4. Click the OK button to record the question. 
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Adding Existing Questions to Tests 
 
With Cognero’s drag-and-drop interface, there are many ways to add existing questions to a 
test. One method is to drag questions from a question set you are viewing in the editor pane. 
This method allows you to see the full text of your questions before adding them to your test. 
 
To add test questions from the editor pane: 
 

1. If necessary, close the currently open test or question set. 
2. Open a question set by dragging it to the editor pane. 
3. Drag a question from the editor pane to a test in the tests pane to add it to the test.  

Hint: Hold the Ctrl key to prevent scrolling while you drag and drop. 
 

 
Figure 8: Drag from editor pane to tests pane 
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Instead, you may wish to add questions to a test that you have open in the editor pane. This 
method allows you to view your test in WYSIWYG mode as you build it. 
 
To add test questions from the question sets panes: 
 

1. If necessary, close the currently open test or question set. 
2. Open your test by dragging it to the editor pane. 
3. Drag a question from the question sets pane to the editor pane to add it to the test. 

Hint: A grey dot indicates that the question is already a part of the currently-open 
test. A green dot indicates the question is available to be added to the test. 
 

 
Figure 9: Drag from question sets pane to editor pane 
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You may wish to add questions to your test based on question meta-data, such as state 
standards or keywords. With Cognero’s powerful search tool, you can filter questions based on 
meta-data to find the exact questions you need. 
 
To add test questions using filters: 
 

1. If necessary, close the currently open test or question set. 
2. Open your test by dragging it to the editor pane. 
3. Click the  (search by criteria) button. 
4. Create a filter. For example, to filter for state standard QCC 5 choose Regional std ID 

as the filter item, choose is as the operation, and enter QCC 5 as the filter value. 
 

 
Figure 10: Search filters 

 
5. If desired, you may add additional filters to further narrow your search. 
6. Click OK. Now only questions that match your search criteria are displayed in the 

question sets pane. 
7. Drag questions from the question sets pane to the editor pane to add them to the test. 
8. To turn filters off and display all questions, simply click the  button again. 
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Formatting and Printing a Test 
 
Cognero provides a variety of options and tools to help you format your test to you exact 
specifications. 
 
To reorder questions: 
 

1. Open a test by dragging it to the editor pane. 
2. Drag a question up or down to change its location within the test. 

 

 
 

3. You also can choose to organize your questions by question type (e.g., true/false, 
matching, etc.). To toggle whether questions are organized by type, click the  
(organize by type) button.  

4. In addition, you can click the  (scramble) button to have Cognero randomize the 
question order for you. 
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To change question number and answer choice styles: 
 

1. Open a test by dragging it to the editor pane. 
2. Choose Styles from the Edit menu. 

 

 
 

3. Change question number and answer choice styles, sequence, and fonts as desired. 
4. Click the OK button to apply your changes. 

 
 
To print a test: 
 

1. Open a test by dragging it to the editor pane. 
2. Choose Print from the File menu. You may choose to print a Single Version or Multiple 

Versions of your test. If you choose to print multiple versions, you can choose from a 
variety of options to make each version of the test unique. You may also choose to 
leave answer space for students to write their answers and to print an answer key. 

3. The print option creates a PDF version of your test. You may save the PDF or send it to 
a printer using your PDF reader. 
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The Cognero Classes and Assignments Window 
 

 
Figure 11: Classes and assignments window 
 
The Classes and Assignments window is organized into three parts: 
 

• Classes Pane: The classes pane lists your classes and students. 
• Tests Pane: The tests pane displays your tests in a folder structure.  
• Editor Pane: Drag a class to the editor pane to edit the class settings and class roster. 

Drag a test to an open class in the editor pane to assign it to students. 
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Working with Classes 
 
The Classes and Assignments component of Cognero enables you to easily set up your classes 
and then create online assignments. With just a few click you can assign a test and the system 
will automatically email invitations to your entire roster. 
 
To open an existing class: 
 

1. Drag the class from the classes pane into the editor pane. 
2. Depending on what you want to do with the class, choose the Assignments, Roster, or 

Settings tab. 
 
 
To create a new class: 
 

1. Click the Create a new class link in the editor pane. 
 

 
Figure 12: New  question set link 

 
2. Enter a class name. You may optionally enter other class information including subject 

area, location, and meeting times. 
3. Click the Next button.  
4. Add students to your class roster. 

• Click the Import button to import your class roster from another Cognero class or 
from a .CSV (comma-separated values), .TSV (tab-separated values), or .XML file. 

• Click the Add Record link to manually add a student to the class. 
5. Check the Enable student self-registration option if you want to allow new students to 

register for your class online.  
6. Click the Next button. 
7. Review the class information on the summary screen. Click the Finish button to save 

your class settings and roster, or click the Back button to change your selections. 



________________________________________________________________________
Cognero Quick Start Guide  17 

Creating an Online Assignment 
 
Once you have created a class, you can assign tests to your students to take online. 
 
To create a new online assignment: 
 

1. Open the class for which you want to create an assignment by dragging the class to the 
editor pane. 

2. Expand folders in the tests pane as necessary until you can see the test you want to 
assign to your class. 

3. Drag the test from the tests pane into the editor pane. 
 

 
 

4. Enter a name for the assignment. 
5. Choose the Recorded Assignment option if you want the assignment results to be 

recorded in the grade book. Choose the Study Guide option to make the assignment 
available to students as an unrecorded practice test. 

6. Choose an assignment category, term, and language. Click the Next button. 
7. You may further specify who has access to the assignment by excluding certain 

students. Choose your access options and click the Next button. 
8. Select the desired availability options. 

• You may choose to limit the number of times each student can take the test. 
• You may choose to set a date and time range when students can take the test. 
• You may choose to set a time limit for completion of the test. 

9. Select the desired presentation options and click the Next button. 
• You may choose to allow students to check their responses. This option is typically 

used in study guides, not recorded assignments. If the content includes feedback 
information, this will be presented to the students when they check their answers. 

• You may choose to scramble the questions. Choosing this option will scramble the 
question order as well as the answer choice order for certain question types such as 
multiple choice. Choosing this option will also recalculate new algorithmic values 
for each student if the test includes algorithmic questions. 
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10. Select the desired end-of-assignment options. You may choose to present students with 
a detailed report, an assignment score, or no information upon completion of their 
online assignment. Click the Next button. 

11. Review the assignment information on the summary screen. If all information is 
correct, click the Email Invites button to email assignment invitations to your class 
roster. Click the Print button to print assignment invitations to give to your students. 
 

 
 

12. Click the Finish button to record your assignment. 
 
Note: As your students take the assignment using the link provided in the email or printed 
invitation, their results will immediately recorded. You can view a variety of class and 
individual student results reports using the Reporting component of Cognero. 
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The Cognero Reporting Window 
 

 
Figure 13: Reporting window 
 
The Reporting window is organized into two parts: 
 

• Classes Pane: The classes pane lists your classes and students. 
• Editor Pane: Drag a class to the editor pane to view and print student results for that 

class. You may also drag individual students if you want to create reports for a certain 
groups of students, or you may drag multiple classes to create comprehensive reports 
for all of your classes. 
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Creating Reports 
 
The Reporting component of Cognero enables you to easily create student and class reports. A 
variety of reports allow you to analyze results based on assignments, question meta-
information such as learning objectives and state standards, and more.  
 
To view and print a report: 
 

1. Drag the students and/or classes on which you want to report from the classes pane 
into the editor pane. 

2. Choose an individual or all students report from the Reports menu. Cognero offers a 
wide variety of reports. 
 
Cognero Reports 
• Individual Assignment Results: This report details a student's performance on a 

selected assignment. 
• Individual Assignment Review: This report enables a student to review their 

mistakes on a selected assignment. 
• Individual Proficiency Report: This report identifies a student's proficiency level 

for all standards. 
• Individual Coverage Lapses: This report identifies any standards that were missed 

by a specific student even though the standards were covered by his/her class. 
• Individual Progress Report: This report details all assignment scores for a student 

during a specified term or all terms. 
• All Students Assignment Results: This report details how all students performed 

on a selected assignment. 
• All Students Question Item Analysis: This report details class performance on 

each question of an assignment. 
• All Students Subjective Responses Worksheet: This report provides a list of all 

subjective questions along with student responses. 
• All Students Progress Report: This report details performance for all assignments 

during a specific term or all terms. 
• All Students Progress Chart: This report provides an easy-to-use visual 

representation of student proficiency levels. 
• All Students Proficiency Report: This report details class performance on all 

standards covered during a specific term or date range. 
 

3. Choose the desired report options and click the OK button. 
4. Your report will open in a separate browser window. You may view the report, print it 

to your printer, or save the report as a .PDF file, an .RTF file, or as an image. 
 
Notes: 

• You may print your overall gradebook by choosing Print from the File menu. 
• You may export your overall gradebook as a .CSV file for use with other gradebook 

software or learning management students. To export your gradebook, choose Export 
from the File menu. 
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Manual Scoring 
 
Most Cognero questions types—such as true/false, multiple choice, and matching—are 
automatically graded when students take online tests. Some question types—such as essay 
questions—must be manually graded by the instructor before their results can be included in 
reports. 
 
To manually score questions: 
 

1. Drag a class from the classes pane to the editor pane to open it. 
2. Click the appropriate column heading to select the assignment for which you want to 

manually score questions. Hint: If an assignment contains questions that need to be 
manually scored, an asterisk will appear next to the assignment score. 

3. Choose Edit Scores from the Assignment menu. 
4. Select a student from the Students list. Questions that need to be scored manually for 

that student will be listed with a red No in the Graded column. 
 

 
 

5. Click the Edit link for the question you want to score. 
6. Enter a score in the Score column and then click the Update link. Note: If you are 

scoring an essay question that has been set up with a scoring rubric, you will need to 
choose scores for each scoring criteria in the question. 

7. Repeat steps 4 through 6 for all students. 
8. Click the Done button. 
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Frequently Asked Questions 
 
 
How do I install the software? 
Because Cognero is a web-based application, no installation is necessary. Simply browse to 
http://www.cognero.com/instructor and you’re ready to start building tests! In order to use 
the word processor to create and edit questions, Java must be installed on your computer. 
Most likely Java is already installed, but if not you can download it for free at 
http://www.java.com.  
 
What browser should I use? 
Cognero supports Firefox 3.5+, Internet Explorer 7+, and Safari 3.1+. While all of these 
browsers will work, Cognero works best with Firefox on Windows and with Safari on the Mac. 
Google Chrome does not currently support the Cognero word processor, but all other Cognero 
features work on Chrome. 
 
Where is the save button? 
Because tests and question sets are automatically saved in real time, you don’t need a save 
button. When you click OK to record a question, it is saved to the database. If a sudden 
network outage or power outage occurs, simply log back into Cognero and the test or question 
set will be just like you left it. 
 
Can I get my content into Cognero from another system? 
Currently, content can be imported from ExamView XML and QTI. Additional import formats 
will be added over time. 
 
What advanced content features are supported by Cognero? 
Cognero’s word processor includes advanced features such as tables, images, hyperlinks, and 
spell check. Media files, such as videos and Flash animations, may be inserted into questions 
for use with online tests. In addition, Cognero features a powerful algorithm engine that allows 
instructors to create and use dynamic questions that can be recalculated with a single click to 
form an entirely new question. 
 
Need more help? 
Detailed, step-by-step instructions for all Cognero features are available in the Cognero online 
help. Just click the Help button from within Cognero to access the online help. 


